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1  Introduction 
 

1.1 Overview of WatPro 
 

WatPro software provides a quick and easy way to evaluate the performance of drinking water 

treatment processes from a microbial and chemical standpoint. The software models (at steady-

state) disinfection by-product (DBP) formation, inactivation of Giardia and viruses, organic 

matter removal, disinfectant decay and pH. The treatment train to be modeled is represented as 

a schematic diagram. 
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2 Design of a Water Treatment Facility 
 

The water treatment facility schematic is the center of the WatPro model.  An example water 

treatment schematic is displayed, as illustrated by the figure below.   

 

 

2.1 Example Water Treatment Plant 
 

The example plant consists of the following processes: 

 Raw water influent 

 Pre-Disinfection (chlorine) and chemical input (alum) 

 Rapid mix/flocculator 

 Settling basin 

 Filters 

 Post-Chlorination and contactor 



WatPro  V4 2016 

 

7  | Hydromantis Environmental Software Solutions, Inc. 

 

 Chemical input (ferrous chloride) 

 Clear Well 

 Effluent 
 

2.2 Toolbars and Menus 
 

A brief introduction of WatPro interface is presented in this section to familiarize the user to the 

organization of various features and functionality available in the simulation system. WatPro 

starts with a program window as shown below. The program window contains the areas for 

Menu Bar, Tool Bar, Hot Spot Bar, Process Tool Bar and Layout Drawing. It also contains the 

two quick output tables summarizing effluent quality and process outputs in the system. 

 

 

Menu Bar - The Menu Bar contains menu items like File, Edit, View, Layout, Model, Analysis 

and Help. The various commands available in each menu item are as shown in the figure below.  

The File menu contains command for retrieving and saving the WatPro files.  
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The Edit menu provides commands for manipulating the layout on the drawing area.  

The View Menu provides many different options for displaying the layout on the drawing area. 

The View Menu also includes the command for viewing the model Preferences like the system 

of units, solver accuracy and other user preferences.  

The Layout menu provides command to manage multiple layouts in the same file. It also 

includes the commands like Site Properties and Hotspots, which are used to set layout specific 

properties.  

The Model menu includes command for checking, solving and viewing results after a layout is 

completely defined. The Model mode has options to verify that process connections are 

complete, to define the format of an output report, to run the model, to customize the model with 

site-specific calibrated parameters, and to identify disinfection byproduct hotspots.  

The Analysis menu provides access to Sensitivity Analysis that enables users to investigate the 

effects of a modeling parameter on DBP formation, microbial disinfection efficiency, or on other 

water quality parameters.  
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The Help menu may be used to access the User’s Guide and Technical Manual. 

 

 

Tool Bar – The Tool Bar contains buttons for some of most often used commands in WatPro. 

The menu items and corresponding commands available on the commands on tool bar are as 

shown below.  

 



WatPro  V4 2016 

 

10  | Hydromantis Environmental Software Solutions, Inc. 

 

 

 

Hot Spot Bar – The Hot Spot Bar provides quick access to view and edit the hot spot display 

setting. It also shows the current color code used for different parameter limits.  

 

 

Process Tool Bar – The Process Tool Bar provides access to all the unit processes available in 

WatPro for layout building. The process units are compiled in different categories of Influents, 

Distribution, Chemical, Solid Separation, Adsorption, Disinfection, Storage and Effluents. The 

unit processes available in any category can be accessed by clicking on the category tab. 
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Layout Drawing Area – The Layout Drawing Area is used for placing the process units and 

connecting them to make a process flow scheme for analysis. The layout drawing area is 

specific to the layout name which appears at the bottom-left of the drawing area. 

 

Final Effluent Summary Table – After the layout is solved, the table is used to show the final 

effluent quality and compliance for the layout. 
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Process Output Summary Table – After the layout is solved, the table shows the outputs of all 

the process units in the system. 

 

 

2.3 Quick Overview of Building a Layout 
 

To construct a water treatment facility begin with a blank drawing area by clicking on the menu 

item FileNew.   

2.3.1 Selecting Unit Processes  

To prepare the plant layout, select the unit processes from the unit process table available at left 

side of the drawing board. The unit process table consists of various tabs containing various unit 

processes. Clicking on any tab expands the tab and provides the details of unit processes 

available in that tab.  

To place the unit process on the drawing board, click on the tab under which the process unit is 

available then drag-n-drop the process onto the desired location on the drawing board.  

To remove a unit process from the drawing board, right-click the mouse button on the process 

and select delete from the pop-up window.  Another way to delete the unit process is by left-

clicking on the unit process [a red border around the object appears] and then accessing the 

delete command inside edit menu or on Tool Bar. The delete key on the keyboard can also be 

used for deleting the unit process.  

To move a process unit from one cell to other, simply drag-n-drop the process to a new location. 

The move operation can also be performed for a group of selected process units.  

When all the process units have been added to the drawing area, optimize the screen view by 

clicking on <View/Zoom> and selecting “to Entire Plant” (Note: the “Zoom to Entire Plant” 

command is also available on Tool Bar for quick access).  

The drawing board after the unit process placement shall appear as shown in the figure below. 
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Continue to click on the process icons and drop them on the drawing area until the process 

schematic is complete. 
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2.3.2 Making Flow Connections  

After all the required process units are placed on the drawing board, the flow connections 

between the unit processes are defined.  

To make a connection between two process units, place the mouse on the outlet arrow 

connection of the unit process from where the connection starts. Once the cursor is at the right 

position, the cursor will change to a grey arrow. 

 

Click-and-drag the arrow from that outlet to the desired inlet on another process. When the 

cursor is at the proper position on the inlet arrow connection, the cursor will change to green to 

indicate that it is an acceptable connection. 

 

Release the mouse button and a connection line between the units will appear. If a connection 

has been made incorrectly or needs to be modified, the existing connection may be deleted by 

right-clicking on the connection between the processes and selecting “Delete Connection”.   
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After all the process connections have been completed, select the menu command 

“Model/Check Connections”.  If a process connection is missing, the model will indicate the 

location of the process that needs the connection.   

Note: the Check Connection feature only identifies the missing connections, it cannot 

determine if the connections are correct. 

 

 

There are several display options in WatPro which are accessible from the View menu. To 

display/hide the process labels select /unselect the Display Process Labels in View menu. 

Similarly, to display/hide the stream labels, select/unselect the Display Stream Labels in View 

menu. The display of process and stream labels can also be turned On/Off by right clicking in an 

empty cell on the drawing board and (un)selecting Display Process Labels or/and Display 

Stream Labels. 

Note: Watpro automatically assigns both the process and stream labels. The process label is 

assigned when the process object is placed from the process table to the drawing board. A 

stream label is assigned when the connection point is connected to a downstream object. To 

change the automatically assigned labels to more meaningful labels, right click on the process 

object and select Edit Labels in the pop-up window. Enter the new process/stream labels in the 

process/stream label field of the edit label window. Press Accept to confirm the changes. 
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2.3.3 Data Entry 

Once the schematic has been verified, entering of the process data can begin.   

Note: WatPro organizes data inputs into three categories - Global Data, Layout Specific Data 

and Unit Process Specific Data.  

2.3.3.1 Global Data 

The Global Data form can be accessed by going to View Menu and clicking on Preferences 

command.  

The Global Data controls the display and model settings for all the layouts in the project file. In 

the Display Settings tab, settings like significant digits in output numbers and Default Unit 

System (metric, US) are accessible to user. In the Model Settings tab user can set the accuracy 

of the steady state solver and can choose the biological model for suspended growth 

processes.  
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2.3.3.2 Layout Specific Data 

The layout specific data is applicable to the layout and can be set for each layout differently.  

These data values are the Hotspot settings under the Layout menu and the Effluent Limits, 

and Calibration options under the Model menu. 

The effluent limits dialog box is used to enter concentration limits needed to be met in the 

effluent. 

 

If the facility final treated water exceeds the maximum allowable concentrations for disinfection 

by-products (total THMs, HAA5, chlorite, chlorate), disinfectant residuals, (chlorine, chloramine, 

chlorine dioxide) or turbidity, the water is considered to be out of compliance.  The Final Effluent 

Summary table discussed previously will reveal the non-compliant parameters. 

WatPro determines a plant’s requirements for Giardia and virus inactivation based on the 

influent water Giardia cyst concentration as specified by the EPA’s Surface Water Treatment 

Rule.  These requirements can be superseded by checking the box. 
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2.3.3.3 Unit Process Data 

In order to specify unit process data, right-click on each process on the drawing area, select Edit 

Parameters, and complete the data entry dialog boxes. It should be noted that as soon as the 

default values are changed the display color changes to blue. This change in color helps user 

keep track of values which are changed in the model. After the changes have been made, the 

user can view the original default values by pointing the cursor over the field. A tool tip will 

display the default value. 

Note: To enter the data in units other than default units, click on the unit label and select the 

required unit in the popup window. 

 

Note: The “Help” button shown in the lower-left corner will give a more in-depth description of 

what each of the input parameters mean. 
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2.3.4 Set Hotspots 

By using the “hotspots” feature, it is possible to visually differentiate the process units which are 

minor/major source of the selected variable in the facility. When the hotspot feature is activated, 

the unit processes appear surrounded by different colors, depending on their concentration.  

To set the levels for the hotspot, access the Hotspots from the Layout menu item. After 

changing the values, click the Accept button to confirm the settings.  

The hot spots will be only visible if the hot spot tool bar is activated from ViewToolbars 

Menu. 

 

 

2.3.5 Rename the Layout 

The name of layout appears at the bottom-left of the drawing area. Right-click on the tab and 

select Rename from the drop down menu. Enter a new name in the layout rename window. 

Press OK to accept the change. 
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3 Simulation and Outputs 
 

3.1 Running the Simulation 
 

Click on the Calculate button on the toolbar to start the calculation.  

 

After the layout is solved and if the hotspots are enabled, the unit processes are presented with 

different colors around them. If the different colors do not appear, then activate the hotspot 

display by selecting Hotspot toolbar from the ViewToolbars menu. The hotspot feature 

provides a quick way to identify the major source of the selected parameter. 
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3.2 View Results 
 

After the layout is successfully solved, the simulation results can be viewed if several different 

ways. 

(1) Right-click on the process and select View Results to view the outputs for that individual 

process. 
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(2) To view a detailed summary of the simulation results for the complete layout, it is better 

to use the View Results button available on the tool bar.  

 
 

 
 

(3) The Final Effluent Summary table and Process Output Summary table displays 

simulation results for the final effluent and every process unit. This data can be exported 

to Excel or the system clipboard by using the Export Data and Copy Table to Clip Board 

buttons provided at the top left side of the table. 

 

  



WatPro  V4 2016 

 

23  | Hydromantis Environmental Software Solutions, Inc. 

 

3.3 Generate Report 

 

In addition to the above features for viewing and exporting data, WatPro allows user to generate 

an elaborate report containing information for all the process units and flow streams.  

To generate a report, select Generate Report from the Model menu and select the desired 

settings. 
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4 Model Calibration 
 

In WatPro, a number of modeled parameters may be calibrated to specific site data.  The 

parameters which may be calibrated include: 

* DBPs formed (total THMs, HAAs, chlorite, chlorate) 
* chlorine consumed (initial demand, decay, filter demand) 
* chlorine dioxide consumed (initial demand, consumption) 

 

Before calibrating the equations in WatPro, it is recommended that the user become familiar 

with the mathematical models associated with the parameters being calibrated (Please refer to 

the Technical Reference document for details). 

 

4.1 Disinfection By-Product Formation 
 

4.1.1 TTHM Formation Calibration 

The total trihalomethanes (TTHM) formation calibration dialog is accessed under the 

Model/Calibration/DBP Formation menu. 

 

 

 

K1 ..... K7:  Variables assigned to calibrate the general TTHM equation. 
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TOC:  total organic carbon concentration in water 

UV254:  absorbance of UV light at wavelength 254 nm by 1 cm of water (cm-1) 

BR:  bromide concentration in water (mg/L) 

ClDose:  assigned chlorine dose for unit process  

T:  temperature (deg C) 

t:  time (t50) at the end of the unit process being considered (hr) 

tp:  time (previous) (t50) at the beginning of the unit process being considered (hr) 

 

Calibration of the WatPro Total THM (TTHM) model improves the predictive accuracy of the 

model relative to the un-calibrated Amy model (Amy et al., 1987), particularly as the temperature 

of the water source declines below approximately15 oC (60oF). 

Calibration of the TTHM model may be accomplished using either spreadsheet packages or a 

statistical software package.  The calibration is performed using a routine that minimizes the sum 

of the squared differences between the measured TTHM concentrations and those predicted by 

the calibrated model. 

The default parameters in the Amy model (see Mathematical Models Chapter) are as follows: 

Parameter Default Value Parameter Default Value 

K1 0.00309 K5 1.06 

K2 0.440 K6 0.409 

K3 0.0358 K7 0.265 

K4 0.715   

 

In the calibrated model, these parameters are adjusted by the procedures indicated above to 

make the formation model match more closely the observed measured TTHM concentrations. 

The model calculates the TTHM concentrations formed in each batch reactor.  Thus, if several 

calibration points are used through the process train, the cumulative predicted TTHM 

concentrations must be used in the exercise.  The increment of time between calibration points is 

used in the model.  When a new chlorine addition point is encountered, the time value used in the 

calibration of the model is reset to zero at the point of injection, and the reaction time begins to 

increase again thereafter.  The Amy model uses chlorine reaction time in units of hours. 
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The Amy model predicts TTHM formation in units of µmole/L.  The average molecular weight 

(AMW) expression from the Mathematical Models Chapter is used to convert the concentrations 

from units of µmole/L to µg/L. 

4.1.2 Chlorite Formation Calibration 

The chlorite formation calibration dialog is accessed under the Model/Calibration/DBP 

Formation menu. 

 

 

K1 ..... K11:  Variables assigned to calibrate the general chlorite equation 

T:  Temperature (deg C)  

ClO2:  Chlorine dioxide dose concentration, mg/L 

RT:  Reaction time (hours) 

WatPro uses a multi-parameter non-linear polynomial expression to estimate chlorite formation 

in each reactor.  Terms for two-parameter interactions are included in the equation, which was 

developed by Korn (1998).  In this equation used in WatPro, TOC has been used in place of the 

non-purgeable organic carbon (NPOC) parameter specified by Korn (1998). Calibration of the 

chlorite formation model is possible to try to improve the predictive accuracy of the model 

relative to the un-calibrated expression. 

The default values of the empirical parameters used in the equation developed by Korn (1998) 

are as follows: 
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Parameter Default Value Parameter Default Value 

K1 -0.346 K7 0.293 

K2 -0.07 K8 0.393 

K3 -0.0253 K9 1.27 

K4 -0.597 K10 0.67 

K5 -0.136 K11 -0.161 

K6 -0.0038   

 

Calibration of the model may be accomplished using either spreadsheet packages or a 

statistical software package.  The calibration is performed using a routine that minimizes the 

sum of the square differences between the measured chlorite concentrations, and those 

predicted by the calibrated model. 

The model calculates the log chlorite concentration (in mg/L) formed in each batch reactor.  

Thus, if several calibration points are used through the process train, the cumulative chlorite 

concentration must be used in the exercise.  The increment of time between the calibration 

points is used in the model.  When a new chlorine dioxide addition point is encountered, the 

time value used in the calibration of the model is reset to 0 at the point of injection, and the 

reaction time begins to increase again thereafter.  At each new chlorine dioxide addition point, 

an initial demand of ClO2 is only asserted if the residual concentration at that point is zero. 

4.1.3 Chlorate Formation Calibration 

The chlorate formation calibration dialog is accessed under the Model/Calibration/DBP 

Formation menu. 
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WatPro uses a multi-parameter non-linear polynomial expression to estimate chlorate formation 

in each reactor.  Terms for two-parameter interactions are included in the equation, which was 

developed by Korn (1998).  In this equation used in WatPro, TOC has been used in place of the 

non-purgeable organic carbon (NPOC) parameter specified by Korn (1998). Calibration of the 

chlorate formation model is possible to try to improve the predictive accuracy of the model 

relative to the un-calibrated expression. 

The default values of the empirical parameters used in the equation developed by Korn (1998) 

are as follows: 

Parameter Default Value Parameter Default Value 

K1 -1.99 K6 0.046 

K2 0.621 K7 0.389 

K3 -0.09 K8 0.346 

K4 0.698 K9 0.486 

K5 -0.104 K10 -0.119 

 

Calibration of the model may be accomplished using spreadsheet packages or a statistical 

software package.  The calibration is performed using a routine that minimizes the sum of the 

square differences between the measured chlorate concentrations, and those predicted by the 

calibrated model. 
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The model calculates the log chlorate concentration (in mg/L) formed in each batch reactor.  

Thus, if several calibration points are used through the process train, the cumulative chlorate 

concentration must be used in the exercise.  The increment of time between the calibration 

points is used in the model.  When a new chlorine dioxide addition point is encountered, the 

time value used in the calibration of the model is reset to 0 at the point of injection, and the 

reaction time begins to increase again thereafter.  At each new chlorine dioxide addition point, 

an initial demand of ClO2 is only asserted if the residual concentration at that point is zero. 

4.2 Chlorine Decay 

4.2.1 Chlorine Initial Demand 

The initial chlorine demand calibration dialog is accessed under the Model/Calibration/Chlorine 

Decay” menu. 

 

The default values of the empirical parameters used in the initial chlorine demand equation are 

as follows: 

 

Parameter Default Value Parameter Default Value 

A -0.62 D 0.842 

B 0.522 E 0 

C 0.302 F 0 
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The form of the calibratable initial chlorine demand equation is similar to the default equation 

used by WatPro (see Mathematical models chapter).  The additional terms of temperature 

(Temp) and pH have been included to provide more flexibility.  It should be noted that when 

calibrating the initial demand equation, the demand due to the presence of ammonia is 

considered separately.  As a result, the chlorine dosage should reflect the concentration after 

ammonia demand has been satisfied. 

Calibration of the initial demand model may be accomplished using either experimental data or, 

if sufficient data are available (e.g. short sample intervals), using field data.  Spreadsheet 

software or a statistical package can be used for calibration purposes. 

4.2.2 Chlorine Decay Calibration 

The chlorine decay calibration dialog is accessed under the Model/Calibration/Chlorine Decay 

menu. 

 

 

The default values of the empirical parameters used in the initial chlorine demand equation are 

as follows: 

Parameter Default Value Parameter Default Value 

1st order 2nd order  1st order 2nd order 

A -1.67 -2.44 E 0 0 

B 0 -1.57 F 0 0 
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C 1 0.799 G 2.73 0 

D 0 0.422 H 0 1 

 

The form of the decay equation is similar to the default model used by WatPro (see 

Mathematical Models Chapter).  The additional terms to account for temperature (Temp) have 

been included to provide more calibration flexibility.  The value of G allows the user to maintain 

the same form of the first and second order equations as presented in the Mathematical Models 

Chapter.  For example, if G were set to 0 then the form of the equation would be similar to the 

first order decay equation presented in the Mathematical Models Chapter.  The order option (set 

at “Both” in the above figure) and the chlorine dosage to TOC ratio boxes are used to indicate if 

the decay equation to be used should be first or second order or if a combination of both should 

be used.  If both are to be used, then the chlorine dosage to TOC ratio is used to determine at 

point the decay is first order and what point it is second order. 

Calibration of chlorine decay may be accomplished using either experimental data or using field 

data.  Spreadsheet software or a statistical package can be used for calibration purposes. 

4.3 Chlorine Dioxide Consumption 
The chlorine dioxide consumption calibration dialog is accessed under the 

Model/Calibration/CLO2 Consumption menu. 

 

The form of the calibratable chlorine dioxide consumption equation is similar to the default 

equation used by WatPro (see Mathematical Models chapter). 

WatPro uses a multi-parameter non-linear polynomial expression to estimate chlorine dioxide 

consumption in each reactor.  Terms for two-parameter interactions are included in the 
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equation, which was developed by Korn (1998).  In this equation used in WatPro, TOC has 

been used in place of the non-purgeable organic carbon (NPOC) parameter specified by Korn 

(1998). Calibration of the chlorine dioxide consumption model is possible using either 

experimental data or field data to try to improve the predictive accuracy of the model relative to 

the un-calibrated expression. A recent spreadsheet software package (such as MS Excel) or a 

statistical package can be used for calibration purposes. The default values of the empirical 

parameters used in the equation developed by Korn (1998) are as follows: 

Parameter Default Value Parameter Default Value 

K1 -0.482 K6 0.162 

K2 0.338 K7 0.361 

K3 -0.0934 K8 0.258 

K4 0.455 K9 0.336 

K5 -0.0288 K10 -0.114 
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5 Sensitivity Analysis 
 

The sensitivity analysis feature allows the user to see the effect of various design and operating 

conditions in the wastewater treatment plant. In essence, the sensitivity analysis adjusts the 

magnitude of the parameter of interest while holding all other test conditions constant.  This 

enables the user to assess which factors are the most important in governing effluent 

concentrations. 

5.1 Setup of Sensitivity Analysis 
Once a treatment plant layout is properly configured, it is possible to run the sensitivity analysis.  

To setup a sensitivity analysis, select Sensitivity Analysis from the Analysis menu. On the 

Sensitivity Setup window, set the process location, independent parameter (X), and dependent 

parameter (Y). 

An example sensitivity analysis dialog box is presented below. 

 

The range over which the sensitivity analysis is to be assessed must be specified. To do this, 

first note the current value specified in the process unit. Then set the low value and the high 

value for the range the effect is to be examined. Set the number of steps to obtain a sufficient 

number of points for assessment. 
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Sensitivity Analysis Options 

View Effect At (Y):  If the treatment plant has more than one process stream as the 

treated plant effluent, the selection is made here.  If there is only one treated water 

stream, it is selected by default. 

Location:  The unit process which contains the parameter to be varied is selected using 

a scroll down menu. 

Parameter (X):  The parameter to be varied (independent variable, X) is selected using 

a scroll down menu. 

Current Value:   This indicates the current value of the independent parameter entered 

in the unit process, and cannot be varied. 

Low Value:  User input for the lowest value to be used for the independent variable (X) 

High Value:  User input for the highest value to be used for the independent variable 

(X). 

Number of Steps:  This indicates the number parameter values that will be used 

(between the low and high X values) for testing the sensitivity analysis. 

Scale Option 

The range of the sensitivity analysis may vary over a small range or over several orders of 

magnitude.  Depending on the portion of the sensitivity analysis curve of greatest interest, a 

user may choose to have the intermediate points of the range estimated on a linear basis or on 

a log basis. 

 

Linear Distribution: The range, as determined by setting the low and high factors, is 

divided by the number of steps -1 (for the initial step with 0 increment). .  Each step is 

incremented by the quantity: 

  ΔX = (Xmax – Xmin)/(#steps – 1) 

   and 

  Xn+1 = Xn + ΔX 
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Log Distribution: The range is established as the difference of the log values of the 

minimum and maximum, and the increment becomes the difference  of the log values of 

the minimum and maximum, divided by the number of steps -1 (for the initial step with 0 

increment). .  Each step is incremented by the quantity: 

  ΔX = [log(Xmax – log(Xmin)]/(#steps – 1) 

   and 

  Xn = 10^(1 + (n – 1)* ΔX) 

 

5.2 Output of Sensitivity Analysis 
Once the sensitivity analysis parameters have been set, the analysis can be run by clicking the 

Run button.  The sensitivity analysis will be performed over the specified number of steps and 

displayed as a graph and table of values. When it is finished, the results of the analysis are 

reported under different tabs.  

On the left side of the graph, the yellow color Up and Down arrows may be used to change the 

scale of the graph. Use the yellow color rectangle to reset the scale. To copy the graph to the 

clip board, use the Copy Image to Clipboard button available below the Graph Legend button.  

In some cases, the range of the sensitivity analysis variable may span over several orders of 

magnitude. In such situation, it may be better to plot the data on a logarithmic scale rather than 

on a linear scale. In the Range Settings header box, user can easily switch between the options 

of Linear Distribution/Logarithmic Distribution. Note that the data curves in the charts remain 

essentially unchanged after the selection is changed from Logarithmic to Linear Distribution, 

however, on the X-axis there are more data points at lower air flow rates than that in the linear 

distribution.  
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6 Additional Topics 

6.1 How to Create Multiple Layouts in the Same File  
WatPro allows users to work with different process layouts in one file. This is useful to the user, 
if it is required to compare two or more different process layouts with few changes. The new 
layouts can be added in the file by either:  
 

(1) From the Layout menu choose Insert to add a blank layout to the file. Alternatively 
to create a duplicate of the current layout, use the Duplicate option. 
 

(2) Right-click on the layout name tab (at the bottom-left of the drawing board) and 
select the Insert option. 

 

6.2 How to Zoom In/Out  
The user can use the ViewZoom command to zoom in and out of the layout. Three Zoom 

buttons are also provided on the tool bar. The Zoom Selected Area button on the tool bar may 

be used to zoom in the selected grid. The Zoom Plant button may be used to zoom to the 

region occupied by the layout. An additional Zoom Out command button is also provided on the 

tool bar. This button may be used to increase the number of rows and columns in the drawing 

board view. 

6.3 How to Set Effluent Limits 
After any simulation run, WatPro compares treated effluent quality to maximum allowable 

concentrations (MACs) specified by the user for certain parameters, including disinfection by-

products (THMs, HAA5, and chlorite), and disinfectant residual concentrations (chlorine and 

chlorine dioxide). These parameters can be set in the Effluent Limits dialog box accessible from 

the ModelEffluent Limits menu. 



WatPro  V4 2016 

 

37  | Hydromantis Environmental Software Solutions, Inc. 

 

 

If the facility final treated water exceeds the maximum allowable concentrations for disinfection 

by-products (total THMs, HAA5, chlorite, chlorate), disinfectant residuals, (chlorine, chloramine, 

chlorine dioxide) or turbidity, the water is considered to be out of compliance.  The Final Effluent 

Summary table discussed previously will reveal the non-compliant parameters. 

WatPro determines a plant’s requirements for Giardia and virus inactivation based on the 

influent water Giardia cyst concentration as specified by the EPA’s Surface Water Treatment 

Rule.  These requirements can be superseded by checking the box. 

6.4 How to Change the System Preferences 
WatPro allows customization of the display, and the selection of default units (metric or U.S.) for 

output on the display and on the printed reports. These options are found in 

ViewPreferences.  The figure below shows the customizations available in WatPro. 
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Display Settings: This setting determines the language, significant digits in output values, 

default units, font size, connection path color display for all of the data entry screens, the model 

report screens, as well as the units in all of the reports.  This setting should be set to the 

preference of the user of the software.   

Model Settings: The model settings feature is used by the model to determine the length and 

accuracy of model iterations; 

 

Certain models in WatPro use an iterative procedure to arrive at a numerical solution.  The 

opportunity for the model to arrive at an iterated solution is determined by the number of 

iterations performed, and by the specified precision of the solution. The model stops the 

iteration procedure if the difference between numerical solutions from successive iterations is 

less than or equal to the specified accuracy, or if the maximum number of iterations has been 

reached without arriving at a solution.  If a solution has not been reached, the user may elect to 

change either the number of iterations or solution accuracy to enable the model to reach a 

solution.  By default, WatPro uses 1000 as the maximum number of iterations, and a solution 

accuracy of 0.001 %. 

Defaults Settings: This setting is used when new schematic configurations are created.  The 

default number of trains (rows) for a drawing is 20.  The basic default number of processes 

(columns) for a drawing is 30.  These values can be changed when more appropriate values for 

the number of rows or columns are required. 
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6.5 How to Rearrange the Flow Lines  
The flow lines can be rearranged for better representation and better tracing of the connection 
points. Rearranging the flow lines can improve the appearance of the plant layouts. In addition 
to moving the flow lines in horizontal and vertical directions, it is possible to add break points to 
create additional line segments.  
The following steps demonstrate the procedure: 
 

(1) Place the cursor on the line which you want to move. The mouse cursor will change into 
an arrow and the selected connection line will automatically turn into red color. Click-
and-drag to move the line in indicated direction.  
 

(2) To create a break-point, right-click the line at the point where the break point is desired. 
From the pop-up menu, select “Create breakpoint”.  

 

6.6 How to View Stream Properties Quickly  
To view the properties of a stream, right-click on the stream and select “View Stream States”. 

The pop-up window will show the calculated values of the stream properties. 

6.7 How to use Hotspots 
With the hotspots feature, after a model has been successfully run, the background of the 

various unit processes is assigned a color coded display depending on the predicted 

concentration. Thus, the display can quickly indicate where “hotspot” concentrations are 

located. The Hotspots feature can be used to follow the progression of modeled parameters 

through the water treatment plant.  

The hotspot toolbar must be displayed for this feature to take effect (accessed through the  

ViewToolbars menu).  A legend is displayed on the toolbar along with a dropdown list to 

select the desired variable and a settings button to access the range settings for each variable.  
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The hotspots display can be de-activated by hiding the Hotspots toolbar. 

 

 

An example of the model configuration after a run with the Hotspots feature activated is shown 

below. 

 

6.8 How to Add Parameters to the Quick Adjust Toolbar  
The Quick Adjust Toolbar is a handy place to isolate certain parameters that you’d like to adjust 

in a readily accessible location so that they can be quickly modified and the layout can be re-

calculated. 

To place a parameter on the quick adjust toolbar, open the Data Entry form by right clicking on 

the object and selecting Edit Parameters. Then right-click on the parameter that needs to be 

placed on the quick adjust toolbar and select the “Pin to Quick Adjust Toolbar”. 
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To differentiate between various parameters, it is a good idea to label these using the “Add a 

Label” command from the Options button available at the top-right of the quick adjust panel. 

Select the parameter above which a label needs to be placed e.g. Flow Rate and click on the 

Options button and Select “Add a Label”. If while adding the label, the label appears at wrong 

place, it is possible to click and move it around. To remove a label, right click on the label and 

select Remove Label. 


